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    At present, the bootloader image 
programming of S32G can generally be used to 
program the M7 image into the QSPI 
NOR/eMMC through the flash tool, or the QSPI 
NOR/eMMC is programmed with a programmer 
and then mounted to PCB. Then the bootloader 
starts and flashes other images to eMMC online, 
but there are two problems with this method: 

1. A bootloader programming station needs 
to be added in the manufacture line.  

2. The method of using external programmer 
may cause the image to be damaged in the SMT 
Reflow.  

Therefore, there are also customers require the 
use of the serial boot function to implement 
direct online programming. 

So maybe it is necessary to directly program 
the S32G image online, but based on the 
following two facts:  

1. Serial boot in ROM Code only supports 
downloading through serial port and CAN port.  

2. In addition to the network port, the fast 
download method can also use USB to download. 
Because the S32G does not have a built-in USB 
PHY, it requires hardware design to connect an 
expensive USB PHY, which is rarely used in 
automotive applications. 

So the more realistic method is to use the 
serial port to download uboot to the internal 
RAM, start the A53, then implement the 
automotive-grade Ethernet PHY or switch driver 
in the uboot driver, and then connect to the 

network port in uboot, use the network port to 
download and burn the image.  

However, the A53 core cannot be started 
directly through the serial boot method, so we need 
to use serial boot to download an M7 image to the 
internal RAM through the serial port, and let the 
M7 image to run first (Serial boot only supports 
starting the M7 core). Then the M7 image 
communicate with PC to  download Uboot to the 
internal RAM, and then M7 image kick off the A53 
start the Uboot.  

This article describes the implementation of 
the above methods and serves as a basis for the 
development of programming tools. 
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1 Development Key Points 
This Tools project diagram as follows: 

 

The key points and difficulties of the development of this tool mainly include the follows： 

Num Development 
or Debug 

Explanation Owner 

1 Development According to the requirements of the serial boot protocol of 
S32G, develop a serial port tool on the PC side to download 
the M7 image 

John.Li 

2 Development According to the requirements of the own customed protocol, 
develop a serial port tool on the PC side to download the A53 
core Bootloader to the SRAM 

John.Li 

3 Development According to the requirements of the own customed protocol, 
develop serial port reception and Checksum logic of M7 
image 

John.Li 

4 Development Modify M7 image to support serial port 0 John.Li 

5 Development Develop and implement the serial port single-byte John.Li 
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synchronous transceiver function of M7 image 

6 Development Develop and implement M7 kick off A53 function John.Li 

7 Debug Debugging to solve the problem of serial port receiving 
garbled characters (Serial boot rom codes are still sending 
messages back to the serial port) 

John.Li 

8 Debug Provide a solution to the A core startup serial port halt idea 
(Serial boot rom codes still occupy the serial port) 

John.Li 

9 Debug Optimize M7 image, reduce size Tony.Zhang 

10 Debug According to the memory allocation requirements of M7 
image and A53 core Uboot in SRAM, rearrange the M7 image 
position to avoid conflicts 

Tony.Zhang 

11 Debug Initialize SRAM space in M7  Tony.Zhang 

12 Debug Setting up SRAM executable space in M7  Tony.Zhang 

13 Debug Debugging to solve the problem of downloading image errors 
caused by cache failure to write back in time 

Tony.Zhang 

14 Debug Integration, Tuning and Documentation John.Li 

So summarize the main points and difficulties encountered and solved by this tool:  

 To adapt to the implementation protocol, a single-byte synchronous access serial port function is 
developed and tuned.  

 According to Debug, it is found that in Serial boot mode, the M7 of HSE will continue to operate 
the serial port, which will cause two problems: 1. A large amount of data will appear when the M7 
serial port on the PC side returns data, 2. Initialization when uboot is started with the serial port is 
used, it will hang directly when exiting the INIT mode and entering the Normal mode. The 
solution is to turn off the serial port operation of the HSE M7 according to the requirements of the 
serail boot protocol.  

 Because the memory distribution of the M7 has been moved, the original M7 MPU register 
settings are incorrect, resulting in the inability to execute code, and the uboot copied to the 
memory through the serial port is not correct in the memory, resulting in uboot execution failure 
(although the serial port data checksum Correct), this is caused by the cache setting, the solution is 
to reconfigure the MPU to modify the target memory to be executable and non-cacheable. 

2 Hardware design description 
The serial boot use UART0, S32G RDB2 design as follows： 
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S32G RDB2 boot mode design as follows: 

 

       Related hardware design as follows： 
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Serial Boot: 
 SW9 -> ALL-OFF 

 SW10 -> ALL-OFF  
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3 Related tools and docs 
Docs： 

Num Tools or Docs Access method Comments 

S32G 
chipset 
reference 
manual 

S32G2RM.pdf https://www.nxp.com/s32g refer boot chapter 

S32DS 
help doc 

S32DS->Help->Help 
Contents-> 

S32 Configuration Tools 
Getting Start->Pin 

S32DS online Doc S32G Pin tools 
description 

S32DS 
help doc 

S32DS->Help->Help 
Contents-> 

S32 Configuration Tools 
Getting Start->Peripherals 

S32DS online Doc S32G Peripherals 
tools description 

S32DS 
help doc 

S32DS->Help->Help 
Contents-> 

S32 Configuration Tools 
Getting Start->IVT Tool 

S32DS online Doc S32G IVT tools 
description  

RTD IM Integration manual \S32DS.3.4\S32DS\ 

software\ 

PlatformSDK_S32XX_2021_05\ 

SW32_RTD_4_4_2_0_0_D2105\ 

Uart_TS_T40D11M20I0R0\doc 

 

RTD UM User manual  

Tools： 

 Refer doc <<S32 Design Studio v3.4.1and RTD 2.0.0 HF3 install 
guide_20210705.pdf>>-Tony.Zhang,Chinese version, to install S32 DS 3.4.1 and RTD 
2.0.0 HF3. 

 Platform_Software_integration: 
Platform_Software_Integration_S32G2XX_2021_04.exe，need to refer its bootloader 
project’s codes of A53 start method. 

 Visual Studio 2019，used to develop the serial tools on PC with C# lauguage. 
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4 Serial Boot boot sequence 
Refer the chipset reference manual: <<S32G2RM.pdf>> 30.12 Serial boot. Serial Boot mode is 

entered via the BOOTMOD input pins. Serial download can also be initiated if the Functional Reset 
Counter(FREC register in the MC_RGM module) reaches a value ≥8. In Serial Boot mode, BootROM 
programs the HSE_H SWT for a 60-second timeout, then continuously polls for activity on any of the 
available interfaces: 

• CAN 
• UART 
If no activity is detected, the timer expires and the core is reset. BootROM sequentially checks for 

activity on all available interfaces and selects the first serial interface that it identifies as active as the 
download interface. The following figure describes the selection process. 
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Download protocol as follows: 
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 Execution process as follows: 
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5  PC side serial download tools development 

5.1 Development environment building 

The serial port download tool on PC side is developed by C#,  so you need to download Visual Stadio. 
You can download the trial version from Microsoft website: 
https://visualstudio.microsoft.com/- >Download Visual Studio - > Community 2019 Community Edition. 
After downloading the installation package, run the installation. 

After installation, open s32gserialboot_ Csharp-> s32gSerialBoot.sln, you may need to install more 
components to support compilation. After installation, you can open the project again. 

After opening, the UI is as follows: 
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You can edit it directly in the code zone, and then compile it in Build - > Rebuild Solution. After 
compilation, click: \ s32gserialboot_ CSharp\s32gserialboot\bin\debug, you can see the successfully 
compiled executable file: s32gserialboot exe. 

The serialport class is used in the source code to access the computer serial port, and the open com 
port function realizes the configuration of the serial port: 

ComPort. PortName = port; 

ComPort. BaudRate = baudrate; 

ComPort. DataBits = 8; 

ComPort. StopBits = (StopBits)Enum. Parse(typeof(StopBits), "One"); 

ComPort. Parity = (Parity)Enum. Parse(typeof(Parity), "Even"); 

The read/write functions are ComPort.Open();ComPort.Write(writeData, 0, 1); 
ComPort.ReadByte();ComPort.Close(); 

The core of the main program is to realize the serial port download protocol, including two parts: 

 According to the data format requirements of s32g serial boot, organize and download M7 image into 
S32G SRAM and run it. 

 Define our own protocol to send the Uboot image with the internal M7 image through the PC serial 
port tools, download it to the S32G SRAM, and notify M7 to start the A53 core. 

5.2 Download the M7 image into SRAM and start M7 core by S32G 
Serial Boot 

Refer the Serial Boot header format in the chipset reference manual: 
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    So to sum up, the information that needs to be added to the M7 image header of serial boot 
includes: 

Header Marker 0xFEEDFACECAFEBEEF 8 Byte  

Image Header 0xD8000060 4 Byte  

Ram Start Point Little-Endian (low address 
first) 

4 Byte Obtained from the address of 
int_sram in the Link file of the 
M7 project 

Ram Entry Point Little-Endian (low address 
first) 

4 Byte Obtained from the address of 
the macro VTABLE in the 
mapping file of the M7 
project 

Image size Little-Endian (low address 
first)0x80000000 

4 Byte | 0x80000000: Turn off the 
continuous operation of the 
serial port by HSE M7 

Reserved 0xFF… 48 Byte  

Image file M7 image raw binary file actual 
image size 

The actual image size cannot 
exceed the SRAM size 

     The following is an example of an actual image: 
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So after this header is added to the downloaded image, the downloaded M7 image can be run 
automatically after downloading. There are two preparation methods:  

1. Using the IVT tool of S32DS, you can check Serial Boot Image and Include Transmission Marker 
in Serial Boot in the Application Boot Code Image column: 

 
2. Another method is to realize the sending bytes of the header in the serial port tool in order to not 

need to package, as follows:  
            sendSerialBootMarker(); 

     sendSerialImageHeader();  
     sendSerialDownloadAddress(addr); 
     sendSerialBootAddress(addr_boot);                     
     sendSerialBootLength((uint)br.BaseStream.Length); 

sendSerial48BytesReserved(); 

   //send image file 
        static void sendSerialBootMarker() 
        { 
            uart_txrx(0xFE); 
            uart_txrx(0xED); 
            uart_txrx(0xFA); 
            uart_txrx(0xCE); 
            uart_txrx(0xCA); 
            uart_txrx(0xFE); 
            uart_txrx(0xBE); 
            uart_txrx(0xEF); 

} 
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       static void sendSerialImageHeader() 
        { 
            uart_txrx(0xD8); 
            uart_txrx(0x00); 
            uart_txrx(0x00); 
            uart_txrx(0x60); 

  } 
        static void sendSerialDownloadAddress(UInt32 address) 
        {// Little-Endian 
            uart_txrx((byte)(address & 0x000000ff)); 
            uart_txrx((byte)((address & 0x0000ff00) >> 8)); 
            uart_txrx((byte)((address & 0x00ff0000) >> 16)); 
            uart_txrx((byte)((address & 0xff000000) >> 24)); 

 } 
        static void sendSerialBootAddress(UInt32 address) 
        {// Little-Endian 
            uart_txrx((byte)(address & 0x000000ff)); 
            uart_txrx((byte)((address & 0x0000ff00) >> 8)); 
            uart_txrx((byte)((address & 0x00ff0000) >> 16)); 
            uart_txrx((byte)((address & 0xff000000) >> 24));  

 } 
        static void sendSerialBootLength(uint length) 
        {// Little-Endian 
             length |= 0x80000000; //important!, which will disable the serial boot rom codes to disable the serial boot 
feedback 

 
            uart_txrx((byte)(length & 0x000000ff)); 
            uart_txrx((byte)((length & 0x0000ff00) >> 8)); 
            uart_txrx((byte)((length & 0x00ff0000) >> 16)); 
            uart_txrx((byte)((length & 0xff000000) >> 24)); 
         } 
        static void sendSerial48BytesReserved() 
        { 
            // write bytes 
            for (int i = 0; i < 48; i++) 
            { 
                uart_txrx(0xFF); 
            } 

} 

        Other main program codes mainly implement the functions of configuring the serial port, reading 
files and sending:  

    static void connect(string port, string baudrate, string file, string address, string boot_address) 
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{… 

if (!openComPort(serialLine, (int)baudr, 2, 1)) // Note that the ROM code of S32G requires 48000 serial ports, 8bit, 2bit 
stop bit and even parity, especially the 2bit stop bit is inconsistent with the chip manual, be careful 

… 
            while (br.BaseStream.Position < br.BaseStream.Length) 
            { 
                byte[] data = br.ReadBytes(64); 

                uart_txrx(data); 

… 

    The actual test results are shown in Chapter 7. 

5.3 Use S32DS M7 serial port driver sample code to download Uboot 
image to SRAM   

You can use the mechanism of Serial Boot to download the binary of a serial port test application 
program M7 project to SRAM to run, and then use this image to continue communication with the serial 
port on the PC side, and download the Uboot image to the corresponding SRAM, which needs to define 
our own protocal as the following code: 
   static void load(string port, string baudrate, string file, string address, string packetsize) 

{… 
if (!openComPort(serialLine, (int)baudr, 1, 3)) // The serial port configuration should be consistent with the M7 

image, here use 1bit stop bit, no parity check method 
… 

                    // marker for data 
                    ComPort.Write(new byte[] { 0x55 }, 0, 1); // Send 0x55, indicating that data is to be sent to an address in 
SRAM                     

// address //send the address 
                    ComPort.Write(new byte[] { (byte)((destAddress & 0x000000ff)) }, 0, 1); 
                    ComPort.Write(new byte[] { (byte)((destAddress & 0x0000ff00) >> 8) }, 0, 1); 
                    ComPort.Write(new byte[] { (byte)((destAddress & 0x00ff0000) >> 16) }, 0, 1); 
                    ComPort.Write(new byte[] { (byte)((destAddress & 0xff000000) >> 24) }, 0, 1); 
 
                    // length //send the Uboot Image size 
                    ComPort.Write(new byte[] { (byte)((transferSize & 0x000000ff)) }, 0, 1); 
                    ComPort.Write(new byte[] { (byte)((transferSize & 0x0000ff00) >> 8) }, 0, 1); 
                    ComPort.Write(new byte[] { (byte)((transferSize & 0x00ff0000) >> 16) }, 0, 1); 
                    ComPort.Write(new byte[] { (byte)((transferSize & 0xff000000) >> 24) }, 0, 1); 
                    //calculate the address+size data checksum 
                    sum += (int)(destAddress & 0xffff); 
                    sum += (int)((destAddress >> 16) & 0xffff); 
                    sum += (int)(transferSize & 0xffff); 
                    sum += (int)((transferSize >> 16) & 0xffff); 
                    while (sum > 0xffff) { sum -= 0xffff; } 
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                    // send payload 
                    // checksum calculated as sum of 16 bit values so we will loop through data 2 bytes at a time 
                    byte[] transfer = new byte[2]; 
                    // write bytes //send the file 

                    ComPort.Write(data, 0, data.Length); 
//Calculate address + size + checksum of file  
//Send the checksum result 
 //Monitor the serial port, wait for the checksum verification result sent by the M7 terminal to the data, and determine 

whether the transmission is successful  
After the program runs successfully, you can use the debugging tool to check the memory content of 

the corresponding download address to see if it is consistent with the downloaded image.  
The PC-side program will also print whether the download is successful according to the returned 

checksum value. 

5.4 Use S32DS M7 serial port driver sample code to start A53 to run 
Uboot in SRAM 

Open the serial port again, and notify M7 to start the A53 from a certain address according to the 
protocol defined by ourselves. The code is as follows: 
   static void execute(string port, string baudrate, string core, string address) 

        {… 
if (!openComPort(serialLine, (int)baudr, 1, 3)) // The serial port configuration should be consistent with the M7 

image, here use 1bit stop bit, no parity check method  
            // marker for data 

            ComPort.Write(new byte[] { 0xaa }, 0, 1); // Send byte 0xaa to notify M7 to start A53 
            // address // send start address 
            ComPort.Write(new byte[] { (byte)((executeAddress & 0x000000ff)) }, 0, 1); 
            ComPort.Write(new byte[] { (byte)((executeAddress & 0x0000ff00) >> 8) }, 0, 1); 
            ComPort.Write(new byte[] { (byte)((executeAddress & 0x00ff0000) >> 16) }, 0, 1); 
            ComPort.Write(new byte[] { (byte)((executeAddress & 0xff000000) >> 24) }, 0, 1); 
            //still make checksum 

sum += (int)(executeAddress & 0xffff); 
            sum += (int)((executeAddress >> 16) & 0xffff); 
         
            // send flags flag to start A53 
            if (core == "A53") 
            {   // A53 
                ComPort.Write(new byte[] { 0x01 }, 0, 1); 
                ComPort.Write(new byte[] { 0x00 }, 0, 1); 
                sum += 0x0001; 
            } 
            else if (core == "M7") 
            {   // M7 
                ComPort.Write(new byte[] { 0x00 }, 0, 1); 
                ComPort.Write(new byte[] { 0x00 }, 0, 1); 
                //sum += 0x0000; 
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            } 

// send checksum 

            // listen for response // Wait for the reply from the M7 side to check whether the checksum is successful, 
indicating whether the command is executed successfully. 

            See Chapter 7 for final test results. 

5.5 Implement the integrated function of download and start 

In order to improve the efficiency, the A53 core image download and startup functions are unified, 
and the option of whether to do checksum is provided, and the function load_to_run is implemented. Its 
essence is consistent with the description in the previous two sections, please refer to the source code. 

6 S23G side M7 image development 

6.1  Preparing the development environment 

Since the Uboot image needs to be downloaded through the serial port, we can develop it based on the 
RTD serial port sample code.  

First, install S32DS v3.4.1+ RTD 2.0.0 according to the document <<S32 Design Studio v3.4.1 and 
RTD 2.0.0 HF3 Installation Guide_20210705.pdf >>-TonyZhang, Chinese version.     

And then, open File->New->S32DS Project from Example, select Uart 
Examples->Linflexd_Uart_Ip_Example_S32G274A_M7. Open the project.  

Then select ConfigTools->Peripherals, click “Update Code” icon to update the code.  

Compile in Project->Build Project.  

Right-click on the project, then Debug As->Debug Configurations->Debugger, check whether the 
Debug Probe Connection is connected to the S32 Debug Probe, or directly click the “Debug” icon to 
download and run this sample program directly. The program will print out serial messages from UART1 
and wait for input (default serial settings are 96000, 8bit, 1bit stop bit, no parity, no flow control). 

6.2 Changing the serial port from 1 to 0 

This sample program uses serial port 1 by default, and Serial boot uses serial port 0, so we first need to 
change the serial port to serial port 0. Need to modify the Pin and serial port driver settings, and the driver 
call. 

1. In ConfigTools->Pin->Routing Details, deleted the default UART1 Pins. Add: 

 LINFlexD_0 rxd [Y12]PC_10 



 

 

 S32G basis of programming tools: serial boot to run A core 

 
 
20   

 

 LINFlexD_0 txd [U11]PC_09 

2. ConfigTools->Peripherals->Components->Drivers->Linflexd_Uart_1->UartGlobalConfi
g->UartHwChannel change to LinflexD_0 

3. Modify the UART port by manual in the initialization in Main function: 
    IntCtrl_Ip_EnableIrq(LINFLEXD0_IRQn); //1 change to 0 
    IntCtrl_Ip_InstallHandler(LINFLEXD0_IRQn, LINFLEXD0_UART_IRQHandler, NULL_PTR); /1 
change to 0 
.. 
    /* Initialize LINFlexD module for UART usage */ 

    Linflexd_Uart_Ip_Init(LINFLEXD_INSTANCE, &Linflexd_Uart_Ip_pHwConfigPB_0_VS_0); /1 change 
to 0 

… 

Linflexd_Uart_Ip_AsyncSend/Linflexd_Uart_Ip_AsyncReceive //handler of call function 

#define LINFLEXD_INSTANCE 0U //johnli 1 change to 0  

After the above modification, and then run the program, you can use serial port 0 to send and receive 
data.  

In addition, this program is a sample program. After modifying it into a download tool, the original 
serial port test code is no longer needed, so after the serial port related initialization is completed, the main 
application program can be deleted. Then the program body call is changed to: 

               Bootloader_listenForPackets();//johli add for main function to enable the download protocol 

This function implements receiving a BYTE from the serial port, and judges whether to receive data 
or execute the startup command according to the BYTE: 
               while(1) { 
  uint8_t receivedByte = in_char(); 
  if (receivedByte == PACKET_DATA){ 
   receivePacketData(); 
  } else if (receivedByte == PACKET_EXECUTE){ 
   receivePacketExecute(); 
   break;   
} 

6.3  Change the baudrate of serial port 

This sample program defaults to 96000 baud rate. In order to improve the download efficiency, it can 
be appropriately increased. Here, first test the 115200 baud rate. 

ConfigTools->Peripherals->Components->Drivers->Linflexd_Uart_1->Desire Buadratechange to 
LINFLEXD_UART_BAUDRAE_115200. 
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6.4 Enable the synchronours single byte transceriver function of serial 
port 

The serial port sample program of RTD is a method of accessing the serial port in an interrupted 
method. This tool transmits each BYTE, and is modified to a non-interrupted polling method to improve 
the efficiency. 

First, comment out the interrupt-related code: 

 main.c: function main: 
    // IntCtrl_Ip_EnableIrq(LINFLEXD0_IRQn); //johli disable interrupt 

    // IntCtrl_Ip_InstallHandler(LINFLEXD0_IRQn, LINFLEXD0_UART_IRQHandler, NULL_PTR); //johli disable 
interrupt 

Only keep the clock, iomux and serial port initialization: 

Clock_Ip_Init(&Mcu_aClockConfigPB[0]); 

Siul2_Port_Ip_Init(NUM_OF_CONFIGURED_PINS0, g_pin_mux_InitConfigArr0); 

Linflexd_Uart_Ip_Init(LINFLEXD_INSTANCE, &Linflexd_Uart_Ip_pHwConfigPB_0_VS_0); 

Then, make a package for the serial port calling API, and use the Polling method to read and write a 
BYTE serial port data: 
char in_char (void) 
{ 
 uint8 rxBuff=0x00; 
 LINFLEXD_Type * pBase; 
 pBase = Linflexd_Uart_Ip_apBases[LINFLEXD_INSTANCE]; 
    /* enable the receiver */ 
    LINFLEXD_SetReceiverState(pBase, TRUE); 
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    /* Wait until data reception flag is set or during reception */ 
    while (!LINFLEXD_GetStatusFlag(pBase, LINFLEXD_UART_DATA_RECEPTION_COMPLETE_FLAG)) 
    { ASM_KEYWORD(" nop "); } 
        /* Retrieve the data */ 
     rxBuff=LINFLEXD_GetRxDataBuffer1Byte(pBase); 
        /* Clear the flags */ 
        LINFLEXD_ClearStatusFlag(pBase, LINFLEXD_UART_DATA_RECEPTION_COMPLETE_FLAG); 
        LINFLEXD_ClearStatusFlag(pBase, LINFLEXD_UART_MESSAGE_BUFFER_FULL_FLAG); 
    /* disable the receiver */ 
   //  LINFLEXD_SetReceiverState(pBase, FALSE);  // Since most of the time is received, it is found in practical 
applications that the receiving function is always turned on, which may improve stability 
 return(rxBuff); 
} 
void out_char (char ch) 
{ 
 LINFLEXD_Type * pBase; 
 pBase = Linflexd_Uart_Ip_apBases[LINFLEXD_INSTANCE]; 
          /* Enable the transmitter */ 
          LINFLEXD_SetTransmitterState(pBase, TRUE); 
              LINFLEXD_ClearStatusFlag(pBase, LINFLEXD_UART_DATA_TRANSMITTED_FLAG); 
              LINFLEXD_SetTxDataBuffer1Byte(pBase, ch); 
              /* Wait until data transmited flag is set during transmission */ 
              while (!LINFLEXD_GetStatusFlag(pBase, LINFLEXD_UART_DATA_TRANSMITTED_FLAG)) 
                 { ASM_KEYWORD(" nop "); } 
          LINFLEXD_ClearStatusFlag(pBase, LINFLEXD_UART_DATA_TRANSMITTED_FLAG); 
          /* Disable the transmitter */ 
          LINFLEXD_SetTransmitterState(pBase, FALSE); 
} 

6.5 Implement data download protocal 

Refer the PC-side tools’ method in Section 4.3, the protocol is implemented: 

Firstly accept the image address and calculate checksum： 
          // get address 
 uint32_t address = 0; 
 address += in_char(); 
 address += (in_char() << 8); 
 address += (in_char() << 16); 
 address += (in_char() << 24); 
 sum = WRAP( (address) & (0xffff)); 

 sum = WRAP( sum + ((address >> 16) & 0xffff)); 

         and then receive the image size and calculate checksum： 
 // get length 
 uint32_t length = 0; 
 length += in_char(); 
 length += (in_char() << 8); 
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 length += (in_char() << 16); 
 length += (in_char() << 24); 
 sum = WRAP( sum + (length & 0xffff)); 

sum = WRAP( sum + ((length >> 16) & 0xffff)); 

Then use 16bit to receive the data to the address, every time the address receives a 16bit data, add 2, 
and then calculate checksum: 
 // copy payload 
 // calculate checksum along the way 
 while(length > 0){ 
  if (length > 1){ 
   first = in_char(); 
   second = in_char(); 
   data = (second << 8) + first; 
   length -= 2; 
  } else { 
   first = in_char(); 
   data = first; 
   length -= 1; 
  } 
  *(uint16_t *) address = data; 
  address += 2; 
  sum = WRAP(sum + data); 

 } 

            And then receive the compare the checksum: 
 // receive and compare checksum 
 uint8_t csumLower = in_char(); 
 uint8_t csumUpper = in_char(); 
 uint16_t csum = (csumUpper << 8) + csumLower; 

sum = WRAP(sum + csum); 

             Finally, according to the checksum result, the download result is sent back: 
              // send response 
 if (sum == 0xFFFF) { 
  // everything ok with transmission 
  out_char(0x00); 
 } else { 
  // transmission error 
  out_char(0xFF); 

 } 

6.6 Implement the A53 start method 

        Refer the PC-side tools’ method in Section 4.4, the protocol is implemented: 

        Firstly, receive the start address and calculate the checksum： 
          // get address 
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 uint32_t address = 0; 
 address += in_char(); 
 address += (in_char() << 8); 
 address += (in_char() << 16); 
 address += (in_char() << 24); 
 sum = WRAP( (address) & (0xffff)); 

 sum = WRAP( sum + ((address >> 16) & 0xffff)); 

          And then receive the flag and calcaulate the checksum, this flag guide to start A54 or M7 
 // get flags 
 uint8_t flagsLower = in_char(); 
 uint8_t flagsUpper = in_char(); 
 uint16_t flags = (flagsUpper << 8) + flagsLower; 

 sum = WRAP(sum + flags); 

           Then compare the sent checksum to see if the protocol codes are sent successfully: 
             // receive and compare checksum 
 uint8_t csumLower = in_char(); 
 uint8_t csumUpper = in_char(); 
 uint16_t csum = (csumUpper << 8) + csumLower; 

 sum = WRAP(sum + csum); 

             Send back a successful flag to the PC: 
 // send response 
 if (sum == 0xFFFF) { 
  // everything ok with transmission 
  out_char(0x33); 
 } else { 
  // transmission error 
  out_char(0x99); 

 } 

Below, if the received boot flag is 1, it means to boot from A53, from the instructions on the chip 
manual: 
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The following codes are the method for M7 to start A53. This method needs to be ported from the 
Bootloader project. The currently installed version of Platform_software_Integration is: 
Platform_Software_Integration_S32G2XX_2021_04.exe After the installation, the code for the M7 to 
start the A53 are: 

          
/*===================================================================================
=============*/ 

/** 

* @brief   Starts an application 
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* @details Starts an application based on the input application configuration 

* @param[in]     applicationConfig The application configuration. 

* return         E_OK if success 

*                E_NOT_OK if error 

*/ 

/*===================================================================================
=============*/ 

uint8_t Bl_StartApplication(Bl_ApplicationDetails * applicationConfig) 

{ 

… 

    if (E_OK == Bl_EnablePartition(partition)) 

    { 

   … 

            status = E_OK; 

    } 

    return status; 

} 

      The simplified code is as follows: 
int EnableA53_0(int coreStartAddress) 
{ 
    /* Keep track of the time needed to start the partition. 
       If it takes too much time, consider the partition disabled */ 
 uint16_t timeout = TIMEOUT_CNT_INIT_VALUE; 
    /* Auxiliary variable used for R/W access to registers */ 
    uint32_t regValue = 0; 
    uint8_t status = E_NOT_OK; 
    uint32_t resetCore; 
 
    int partition=1; //A53 is partition 1 
    int coreId=0; //first A53 
    /* Set the core Vector Table address before enabling the partition */ 
    REG_WRITE32 (MC_ME_PRTN_N_CORE_M_ADDR(partition, coreId), coreStartAddress); 
 
//enable partition: 
    /* enable clock partition */ 
    REG_WRITE32 (MC_ME_PRTN_N_PCONF(partition), MC_ME_PARTITION_CLOCK_ENABLE); 
 
    /* trigger hardware process for enabling clocks */ 
    REG_WRITE32 (MC_ME_PRTN_N_PUPD(partition), MC_ME_TRIGGER_PROCESS); 
 
    /* write the valid key sequence */ 
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    REG_WRITE32 (MC_ME_CTL_KEY_ADDR, MC_ME_CTL_KEY_VALUE); 
    REG_WRITE32 (MC_ME_CTL_KEY_ADDR, MC_ME_CTL_KEY_INVERTED_VALUE); 
 
    /* wait for partition clock status bit */ 
    while (((REG_READ32(MC_ME_PRTN_N_STAT(partition)) & MC_ME_PARTITION_CLOCK_ENABLE) != 1) 
&& (timeout--)); 
 
    /* unlock software reset domain control register */ 
    regValue = REG_READ32(RDC_RD1_CTRL_REGISTER) | RDC_RD1_CTRL_UNLOCK_ENABLE; 
    REG_WRITE32(RDC_RD1_CTRL_REGISTER, regValue); 
 
    /* enable the interconnect interface of software reset domain */ 
    regValue = REG_READ32(RDC_RD1_CTRL_REGISTER) & RDC_RD1_XBAR_INTERFACE_DISABLE; 
    REG_WRITE32(RDC_RD1_CTRL_REGISTER, regValue); 
 
    /* wait for software reset domain status register 
       to acknowledge interconnect interface not disabled */ 
    while((((REG_READ32(RDC_RD1_STAT_REGISTER)) & RDC_RD1_XBAR_INTERFACE_STAT) != E_OK) 
&& (timeout--)); 
 
    /* cluster reset */ 
    regValue = REG_READ32(RGM_PRST(partition)) & RGM_PRST_CLUSTER; 
    REG_WRITE32 (RGM_PRST(partition), regValue); 
 
    regValue = REG_READ32(MC_ME_PRTN_N_PCONF(partition)) & MC_ME_OUTPUT_PARTITION; 
    REG_WRITE32 (MC_ME_PRTN_N_PCONF(partition), regValue); 
 
    regValue = REG_READ32(MC_ME_PRTN_N_PUPD(partition)) | MC_ME_OUTPUT_STATUS; 
    REG_WRITE32 (MC_ME_PRTN_N_PUPD(partition), regValue); 
 
    /* write the valid key sequence */ 
    REG_WRITE32 (MC_ME_CTL_KEY_ADDR, MC_ME_CTL_KEY_VALUE); 
    REG_WRITE32 (MC_ME_CTL_KEY_ADDR, MC_ME_CTL_KEY_INVERTED_VALUE); 
 
    /* wait until cluster is not in reset */ 
    while ((REG_READ32(RGM_PSTAT(partition)) & RGM_PSTAT_RESET_STATE) != E_OK); 
    while (((REG_READ32(MC_ME_PRTN_N_STAT(partition)) & MC_ME_OUTPUT_STATUS) != 0x0) && 
(timeout--)); 
 
    /* lock the reset domain controller */ 
    regValue = REG_READ32(RDC_RD1_CTRL_REGISTER) & RDC_RD1_CTRL_UNLOCK_DISABLE; 
    REG_WRITE32(RDC_RD1_CTRL_REGISTER, regValue); 
 
    if (TIMEOUT_CNT_END_VALUE != timeout) 
    { 
        status = E_OK; 
    } 
    else 
    { 
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     return(status); 
    } 
//end enable partitio 
 
    /* enable core clock */ 
    REG_WRITE32 (MC_ME_PRTN_N_CORE_M_PCONF(partition, coreId), 1); 
 
    /* Partition peripherals are always enabled in partition 0 */ 
    if (0 != partition) //PARTITION_0=0 
    { 
        REG_WRITE32 (MC_ME_PRTN_N_PCONF(partition), 1); 
    } 
    /* trigger hardware process */ 
    REG_WRITE32 (MC_ME_PRTN_N_CORE_M_PUPD(partition, coreId), 1); 
 
    /* write key sequence */ 
    REG_WRITE32 (MC_ME_CTL_KEY_ADDR, MC_ME_CTL_KEY_VALUE); 
    REG_WRITE32 (MC_ME_CTL_KEY_ADDR, MC_ME_CTL_KEY_INVERTED_VALUE); 
 
    /* wait for clock to be enabled */ 
    /* @Todo: Move to SysDAL routines the wait for clock and core cluster reset. Call them here through API */ 
    while (((REG_READ32(MC_ME_PRTN_N_CORE_M_STAT(partition, coreId)) && 
MC_ME_CORE_CLOCK_STAT_MASK) != 1) && (timeout--)) ; 
    while (((REG_READ32(MC_ME_PRTN_N_STAT(partition)) & MC_ME_CLOCK_ACTIVE) != 1) && 
(timeout--)); 
 
    /* pull the core out of reset and wait for it */ 
    resetCore = REG_READ32(RGM_PRST(partition)) & RGM_PRST_RESET_CORE(partition, coreId); 
    REG_WRITE32 (RGM_PRST(partition), resetCore); 
    while ((REG_READ32(RGM_PSTAT(partition)) & RGM_PRST_STATUS_CORE(partition, coreId)) != 0); 
 
    if (TIMEOUT_CNT_END_VALUE != timeout) 
    { 
        status = E_OK; 
    } 
    else 
    { 
     return(status); 
    } 

} 

    Finally, this function is called in the receivePacketExecute function to start the A53: 
 } else if (flags == 0x0001) { 
  // bring up A53 Core 0 
  EnableA53_0(address); 

 } 

 To avoid the conflict between uboot's 53 clock initialization and serial port initialization and the code 
of M7, deinitialize the clk of the serial port before running A53: 
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     Linflexd_Uart_Ip_Deinit(LINFLEXD_INSTANCE); //johnli li disable uart  

The deinitialization function of the clock needs to expose the local statically linked function: 

RTD/src/Clock_Ip.c 
// static void ResetClockConfiguration(Clock_Ip_ClockConfigType const * config) 

void ResetClockConfiguration(Clock_Ip_ClockConfigType const * config) //johnli modify 

RTD/include/Clock_Ip.h 

void ResetClockConfiguration(Clock_Ip_ClockConfigType const * config); //johnli add 

src/main.c 
    ResetClockConfiguration(&Mcu_aClockConfigPB[0]); //johnli reset clock 

EnableA53_0(address_run); 

 Be careful not to overwrite the code of the project with Update Code Command. 

6.7 Implement the integrated function of download and start 

To provide efficiency, the A53 core image download and startup functions are unified, and the option 
of whether to do checksum is provided, and the function receivePacketData_to_run is implemented. The 
essence is the same as the description in the previous two chapters. 

6.8 Optimize the image size and avoid conflict with Uboot image 

Serial download requires the use of raw binary files, and S32DS only compiles elf files for debugger 
download by default, so first configure the output bin file: 

Project->Properities->C/C++ Build->Settings->checked Create flash image，Apply and Close. 

And then, will pop up: Standard S3DS Create Flash Image->General, change Output file format(-O) 
to Raw binary: 
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In this way, the *.bin file can be compiled, but the size of the compiled image is 5.377KB by default, 
and the corresponding elf is only 1.754KB, so such binary download by serial port will affect the 
efficiency (the default serial boot baud rate of ROM codes is only 48000). 

        So change the Link file as follows: 
 The link file of the sample project is just an example, and users can redistribute the link file 

according to their own needs. 
/Project Explorer/Project/Project_Settings/Linker_Files/linker_ram.ld, which MEMORY defined as 

follows： 
MEMORY  
{          
    int_itcm                : ORIGIN = 0x00000000, LENGTH = 0x00000000 /* 0KB - Not Supported */ 
    int_dtcm                : ORIGIN = 0x20000000, LENGTH = 0x00010000 /* 64K */ 
    int_sram_shareable      : ORIGIN = 0x22C00000, LENGTH = 0x00004000 /* 16KB */ 
    int_sram                : ORIGIN = 0x34000000, LENGTH = 0x00400000 /* 4MB */ 
    int_sram_stack_c0       : ORIGIN = 0x34400000, LENGTH = 0x00002000 /* 8KB  */ 
    int_sram_stack_c1       : ORIGIN = 0x34402000, LENGTH = 0x00002000 /* 8KB  */ 
    int_sram_stack_c2       : ORIGIN = 0x34404000, LENGTH = 0x00002000 /* 8KB  */ 
    int_sram_no_cacheable   : ORIGIN = 0x34500000, LENGTH = 0x00100000 /* 1MB, needs to include int_results  */ 
 
   Among them, int_sram_no_cacheable is linked to the 5M start address, but the vector table intc_vector 
defined in: 
.non_cacheable : 
    { 
        . = ALIGN(4); 
        KEEP(*(.int_results))   
        . += 0x100; 
        . = ALIGN(4096); 
        __interrupts_ram_start = .; 
        KEEP(*(.intc_vector))     
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        . = ALIGN(4); 
 In this position, the compiled binary image is too large. 
vector table in the file/Project Explorer/Project/Project_Settings/Startup_Code/Vector_Table.s 

defined in .intc_vector segment: 
.section  ".intc_vector","ax" 
.align 2 
.thumb 
.globl undefined_handler 
.globl undefined_handler 
.globl VTABLE 
… 

So in order to reduce the code size and avoid the uboot code segment, as follows: 
 Modify the linker_ram.ld’s non_cacheable segment，and put this segment into int_sram, After 

compiling this way, you will find that the entire code becomes smaller. 
    .non_cacheable : 
    {… 
    } > int_sram 
      After compiling, the bin file becomes 257KB. 
 In order to avoid the uboot code segment and prevent conflict with each other, we move the M7 image 

to the 5M position of the SRAM: 
    reserveda_to_a53_sram   : ORIGIN = 0x34000000, LENGTH = 0x00500000 /* 5MB */ 
    int_sram                : ORIGIN = 0x34500000, LENGTH = 0x00080000 /* 512KBsize 5M offsite */ 
    int_sram_stack_c0       : ORIGIN = 0x34580000, LENGTH = 0x00002000 /* 8KB  */ 
    int_sram_stack_c1       : ORIGIN = 0x34582000, LENGTH = 0x00002000 /* 8KB  */ 
    int_sram_stack_c2       : ORIGIN = 0x34584000, LENGTH = 0x00002000 /* 8KB  */ 
    int_sram_no_cacheable   : ORIGIN = 0x34588000, LENGTH = 0x00078000 /* 480KB, needs to include 
int_results  */ 
    ram_rsvd2               : ORIGIN = 0x34600000, LENGTH = 0          /* End of SRAM 6M offsite */ 
/* 
   * int_sram                : ORIGIN = 0x34000000, LENGTH = 0x00400000 // 4MB  
   * int_sram_stack_c0       : ORIGIN = 0x34400000, LENGTH = 0x00002000 // 8KB  
   * int_sram_stack_c1       : ORIGIN = 0x34402000, LENGTH = 0x00002000 //8KB   
   * int_sram_stack_c2       : ORIGIN = 0x34404000, LENGTH = 0x00002000 // 8KB   
   * int_sram_no_cacheable   : ORIGIN = 0x34500000, LENGTH = 0x00100000 // 1MB, needs to include 
int_results   
   * ram_rsvd2               : ORIGIN = 0x34600000, LENGTH = 0          // End of SRAM  
*/ 

 If you want to start through Serial Boot mode, you need to add SRAM initialization except the  code 
segment. In the link file, add a symbol at the end of the code named "__customer_code_end", and 
define a macro CUSTOMER_CODE_END. Also you can define CUSTOMER_CODE_START. 

 
SECTIONS 
{ 
     
    .sram : 
    { 
        __customer_code_start = .; 
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        . = ALIGN(4); 
        KEEP(*(.core_loop)) 
… 
  } > int_sram 
   .non_cacheable : 
    {… 
        KEEP(*(.pfe_bd_mem)) 
        __customer_code_end = .; 
    } > int_sram 
… 
    __INT_SRAM_START         = ORIGIN(reserveda_to_a53_sram); // This is 0~5M SRAM space, reserved for uboot 
code 
    __INT_SRAM_END           = ORIGIN(int_sram); 
     
   __INT_SRAM_START_2         = __customer_code_end; // This is the remaining space of the mirror after the M7 starts 
from 5M 
   __INT_SRAM_END_2           = ORIGIN(ram_rsvd2); 
/* 
  *  __INT_SRAM_START         = ORIGIN(int_sram); 
  * __INT_SRAM_END           = ORIGIN(ram_rsvd2); 
*/ 
 Enable RAM_INIT 

__RAM_INIT               = 1; 
 Open file/Project Explorer/Project/Project_Settings/Startup_Code/startup_cm7.s 

By default RamInit is not executed because RAM_INIT is 0 by default. We use this assembly 
function to initialize SRAM ECC. The address range is a zone except CODE segment, so there are two 
zone, and the function needs to be modified. 

 
RamInit: 
    /* Initialize SRAM ECC */ 
    ldr  r0, =__RAM_INIT 
    cmp  r0, 0 
    /* Skip if __SRAM_INIT is not set */ 
    beq SRAM_LOOP_END 
    ldr r1, =__INT_SRAM_START 
    ldr r2, =__INT_SRAM_END 
     
    subs    r2, r1 
    subs    r2, #1 
    ble SRAM_LOOP_END 
 
    movs    r0, 0 
    movs    r3, 0 
SRAM_LOOP: 
    stm r1!, {r0,r3} 
    subs r2, 8 
    bge SRAM_LOOP 
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    /*johnli remove segment2*/ 
    ldr r1, =__INT_SRAM_START_2 
    ldr r2, =__INT_SRAM_END_2 
 
    subs    r2, r1 
    subs    r2, #1 
    ble SRAM_LOOP_END 
 
    movs    r0, 0 
    movs    r3, 0 
SRAM_LOOP_2: 
    stm r1!, {r0,r3} 
    subs r2, 8 
    bge SRAM_LOOP_2 
 
     /*johnli remove segment2 end*/ 
SRAM_LOOP_END: 
Therefore, the original code cannot be executed, and the entire RAM will be cleared (the code of the 

traditional MCU is in the internal Flash, and the SRAM can be completely cleared). 
 

 After this operation, compile again, the bin file is 257KB, and the size of the text displayed in the 
console after compilation is the same. 
 

arm-none-eabi-size --format=berkeley Linflexd_Uart_Ip_Example_S32G274A_M7.elf 
   text    data     bss     dec     hex filename 
 262152       0   12288  274440   43008 Linflexd_Uart_Ip_Example_S32G274A_M7.elf 

Related mapping file： 
.sram           0x34500000     0x5c5c 

                0x34500000                __customer_code_start = . 

… 
*(.pfe_bd_mem) 

                0x34540000                __customer_code_end = . 

6.9 M7’s MPU settings 

MPU concept: MPU Protection Regions The MPU in the ARM processor uses "regions" to manage 
memory cells. Domains are attributes associated with memory spaces that the processor core holds in 
some registers of the coprocessor CP15. Usually the number of fields is 8, numbered from 0 to 7. The size 
and start address of the field are stored in register c6 of the CP15. The size can be any power of 2 from 
4KB to 4GB. The starting address of a field must be a multiple of its size. For example, a domain defined 
as 4KB can start at 0x12345000, while a domain defined as 8KB can only start at a multiple of 0x2000. In 
addition, the operating system can assign more attributes to these fields: access rights, cache, and write 
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cache. The memory can set the access rights of these areas to read/write, read-only and inaccessible based 
on the processor mode (admin mode or user mode) at that time. 

       The MPU registers in the M7 project source code are set as follows: 
C:/NXP/S32DS.3.4/S32DS/software/PlatformSDK_S32XX_2021_05/SW32_RTD…/Platform_TS_.../st
artup/include/core_specific.h 
/* 
  Region  Description        Start       End           Size[KB]  Type              Inner Cache Policy    Outer Cache Policy    Shareable    
Executable    Privileged Access    Unprivileged Access 
--------  -----------------  ----------  ----------  ----------  ----------------  --------------------  --------------------  -----------  
------------  -------------------  --------------------- 
… 
       5  RAM(1st 4MB)       0x34000000  0x343FFFFF        4096  Normal            Write-Back/Allocate   Write-Back/Allocate   
No           Yes           Read/Write           Read/Write 
       6  RAM(2MB)           0x34400000  0x345FFFFF        2048  Normal            Write-Back/Allocate   Write-Back/Allocate   
No           Yes           Read/Write           Read/Write 
       7  Non-Cacheable RAM  0x34500000  0x345FFFFF        1024  Normal            None                  None                  Yes          
Yes           Read/Write           Read/Write 
… 

*/ 

       static const uint32 rbar[CPU_MPU_MEMORY_COUNT] = {…, 0x34000000UL, 0x34400000UL, 
0x34500000UL, …}; 

static const uint32 rasr[CPU_MPU_MEMORY_COUNT] = {…, 0x030B002BUL, 0x030B0029UL, 
0x130C0027UL, …}; 

       rasr register define as follows: refer the doc <<ARM® Cortex®-M7 Processor User Guide  Revision: 
r1p1 Reference Material>>: 
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So after modifying the memory allocation, there will be two problems:  

 The original default address space allocated at 0x34500000UL is XN=1, which means that the code 
cannot be executed, because we re-allocate the code of M7 to this address, so XN needs to be changed 
to 0: 0x030C0027UL  

 The TEXT C B S segment of the address space 0x34000000UL (rasr=0x030B002BUL) of the 
original code where M7 is located is: 001 1 1 0, that is, the attributes of Normal memory, Not 
shareable, Outer and inner write-back, write and read allocate. In the actual test, it was found that after 
opening the cache, the data written by the serial port to this memory will be incorrect in the memory. 
In this case, Uboot fails to execute, so close the cache and set it to 001 0 0 1, which is the way of 
Normal memory, Shareable, outer and inner noncacheable, 0x34000000UL (rasr=0x030C002BUL)   

Of course, there is an easier way is to not set the MPU register. 
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7 Test guide and results 

7.1 Dowload the M7 Image 

Refer Project Explorer/Project/Project_Settings/Linker_Files/Linker_ram.ld to get the M7 image 
download address: 
MEMORY  
{ … 

    int_sram                : ORIGIN = 0x34500000, LENGTH = 0x00400000 /* 4MB */ 

Refer Project Explorer/Project/Debug_RAM/project.map file to get the M7 image start up address: 
.intc_vector   0x34506000      0x408 ./Project_Settings/Startup_Code/Vector_Table.o 

                0x34506000                VTABLE 

          So use Serial Boot to download the M7 image (modified to 115200_bootloader.bin, put it in the 
same directory as s32gSerialBoot.exe, open the windows terminal) to S32G and execute the command: 

s32gSerialBoot.exe connect COM22 48000 115200_bootloader.bin 0x34500000 0x34506000 

          The results as follows： 

********s32g Serial Boot Loader Tool******** 

Connecting and overriding intial bootloader 

… 

Total bytes transferred: 262152 

7.2 Tools’ PING and Help feature 

Download the M7 image and excute: 

s32gSerialBoot.exe ping COM22 115200 

********s32g Serial Boot Loader Tool******** 

PING: The target is running the overriden bootloader 

Which can check whether the M7 image is running or not, help as follows: 

s32gSerialBoot.exe help 

********s32g Serial Boot Loader Tool******** 

Utility to load a program serially on the s32g 

 

USAGE: 
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To connect and override the serial boot rom code with m7 kernel bootloader use the command connect 

Syntax: s32g_serialboot connect COM_PORT  baudrate file_name download_address run_address 

Example:s32gSerialBoot.exe connect COM22 48000 115200_bootloader.bin 0x34500000 0x34506000 

 

To load a A kernel bootloader to a specific address use the command load 

Syntax: s32g_serialboot load COM_PORT baudrate connect download_address 

Example: s32gSerialBoot.exe load COM22 115200 u-boot.bin 0x34090000 

 

To start execution, there is the option to start with the M7 or A53 core 

Syntax: s32g_serialboot run COM_PORT baudrate kernal_flag execute address 

Example: s32gSerialBoot.exe run COM22 115200 A53 0x340a0000 

 

To ping the status of the targed, use the ping command 

Syntax: s32g_serialboot ping COM_PORT baudrate 

Example: s32g_serialboot ping COM22 115200 

7.3 Download Uboot image 

Build a S32G Uboot image and compiling envrinment. 

Refer file：/u-boot/board/freescale/s32-gen1/Kconfig/ to get: 

config SYS_TEXT_BASE 

        default 0xff8a0000 if S32_ATF_BOOT_FLOW 

        default 0x340a0000 

After Command “make s32g274ardb2_defconfig”,  it can be gotten from /u-boot/.config： 

CONFIG_SYS_TEXT_BASE=0x340a0000 

After compiling，it can be gotten from /u-boot/u-boot.map for the execute address: 

Linker script and memory map 

Address of section .text set to 0x340a0000 

                0x0000000000000000                . = 0x0 

                0x0000000000000000                . = ALIGN (0x8) 

 

.text           0x00000000340a0000    0x607dc 

 *(.__image_copy_start) 
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 .__image_copy_start 

                0x00000000340a0000        0x0 arch/arm/lib/built-in.o 

                0x00000000340a0000                __image_copy_start 

 arch/arm/cpu/armv8/start.o(.text*) 

 .text          0x00000000340a0000      0x1e0 arch/arm/cpu/armv8/start.o 

                0x00000000340a0000                _start 

But please attention to: 

 Arch\arm\mach-s32\makefile 

u-boot.s32: u-boot.bin FORCE 

ifeq ($(CONFIG_S32_GEN1),y) 

 $(eval DTB_RSRVD_SIZE = $(shell \ 

  echo $$((${CONFIG_SYS_TEXT_BASE} - ${CONFIG_DTB_SRAM_ADDR})))) 

 $(eval DTB_SIZE = $(shell stat --printf="%s" u-boot.dtb)) 

 

 @if [ ${DTB_SIZE} -gt ${DTB_RSRVD_SIZE} ]; then \ 

  echo "DTB exceeds the reserved space of" \ 

  "${DTB_RSRVD_SIZE} bytes between CONFIG_SYS_TEXT_BASE" \ 

  "and CONFIG_DTB_SRAM_ADDR"; \ 

  false; \ 

 fi 

 

 @dd if=u-boot.dtb of=u-boot-with-dtb.bin bs=${DTB_RSRVD_SIZE} count=1 

 @dd if=u-boot.bin of=u-boot-with-dtb.bin bs=${DTB_RSRVD_SIZE} seek=1 

     So Makefile will package Uboot's DTB Image in front of Uboot's header, starting from 
CONFIG_DTB_SRAM_ADDR. 

     The macron is defined in /u-boot/board/freescale/s32-gen1/Kconfig: 

config DTB_SRAM_ADDR 

 hex "SRAM address at which the dtb will be found" if !S32_ATF_BOOT_FLOW 

 default 0xff890000 if S32_ATF_BOOT_FLOW 

 default 0x34090000 

    So the download address of Uboot is 0x34090000, and the execution address is 0x340a0000: The 
Uboot image download execution command is:  

s32gSerialBoot.exe load COM22 115200 u-boot.bin 0x34090000// Note to download *.bin not *.s32 file. 
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  Execute results： 

********s32g Serial Boot Loader Tool******** 

Loading binary file 

 

write data length 785375 

bytesTransfered pkt size 785375, checksum ok 

Transfer complete 

7.4 Execute the A53 start command 

According to the above analysis, the start address of M7 to start A53 is 0x340a0000, so the execution 
command is:  

s32gSerialBoot.exe run COM22 115200 A53 0x340a0000 

Execute results on PC as follows: 

********s32g Serial Boot Loader Tool******** 

Launching exection command 

execute checksum ok 

On the PC side, after the execution of s32gSerialBoot.exe is completed, open the serial port and 
configure it as 115200, 8bit, 1bit stop bit, no parity, no stop bit, you can see that Uboot has been executed 
correctly. 

7.5 Integration test 

As mentioned in section 5.5 and 6.7, the code implement the integrated function of downloading and 
starting, and provides the ability to open checksum, so a bat file is implemented as follows 

s32gSerialBoot.exe connect COM22 48000 115200_bootloader.bin 0x34500000 0x34506000 

echo wait for some time 

TIMEOUT /T 3 

s32gSerialBoot.exe load_to_run COM22 115200 u-boot.bin 0x34090000 0x340A0000 false 

Double-click to open the serial port after the operation is completed, and you can see that Uboot has 
been executed. 

7.6 Baudrate limitation test 

 In the M7 Project, change the serial baudrate to the maxim: 
ConfigTools->Peripherals->Components->Linflexd_Uart_1->UartGlobalConfig: 
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Change Desire Baudrate toLINFLEXD_UART_BAUDRATE_921600. 

Modified and Update Code, check the source codes as follows：
generate/src/Linflexd_Uart_lp_VS_0_PBcfg.c 
const Linflexd_Uart_Ip_UserConfigType Linflexd_Uart_Ip_pHwConfigPB_0_VS_0 = 
{ 
    /* Actual baudrate */ 

    921600, 

And then compile to bin file and copy to rename to 921600_bootloader.bin and execute: 

s32gSerialBoot.exe connect COM22 48000 921600_bootloader.bin 0x34500000 0x34506000 

********s32g Serial Boot Loader Tool******** 

Connecting and overriding intial bootloader 

Total bytes transferred: 4096 

… 

Total bytes transferred: 262152 

s32gSerialBoot.exe load_to_run COM22 921600 u-boot.bin 0x34090000 0x340A0000 true 

********s32g Serial Boot Loader Tool******** 

Launching load to run command 

header sum=25598 

write data length 785375 

sum=4191,csum=-4192 

bytesTransfered pkt size 785375, checksum ok 

Transfer complete:785375 

And then open serial tools, will found Uboot is workable. 

But If the baudrate is set to LINFLEXD_UART_BAUDRATE_1843200, the test fails. It can be seen 
that the current implementation method can test the baud rate of about 1M on the S32G RDB2 board. 

8 Release readme 
   The description of the code package directory released by this tool is as follows: 

    Release 

     |->M7: Linflexd_Uart_Ip_Example_S32G274A_M7: S32DS M7 project folder. 

     |->PC: s32gSerialBoot_Csharp: PC side Visual Studio developed C# serial tools project source folder. 

     |->Test: 
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     |    |-> 115200_bootloader.bin: S32DS M7 project compiled bin file, baudrate is 115200. 

     |    |-> 921600_bootloader.bin: S32DS M7 project compiled bin file, baudrate is 921600 

     |    |->load_uboot.bat: The batch file of the tool. After successful operation, open the serial port to see 
the Uboot execution. The default baud rate is 115200. 

        |    |->readme.txt: other test command. 

|    |->s32gSerialBoot.exe: compiled PC side serial tools execute file. 

|    |->u-boot.bin: BSP29 default u-boot.bin image. 

9  Future development plan explanation 
     This tool and document show how to run a Uboot image through the serial boot. This is a basis for 

R&D or manufacture on-line programming of images. After running uboot, there is an opportunity to 

operate a high-speed interface (such as Ethernet or USB interface) to program the big image as linux 

kernel&rootfs, and the uboot+Linux kernel&rootfs can also provide more and more flexible programming 

tools, and the on-line programming method depends on customer customization, and there is no certain 

rule. The general ideas are:  

 Through Uboot's Ethernet driver, tftp into the kernel image, and then mount the network terminal file 

system to run a Linux for burning, or tftp kernel + ramrootfs can also be used. This requires 

customizing Uboot's Ethernet PHY or Switcher driver and customizing related Linux tools. (Please 

check doc << Download images into eMMC by NFS in S32G.PDF>> author: WT Aaron.Zeng, which 

can use tftp+NFS to burn the Linux image into eMMC). 

 Use USB fastboot to load Linux kernel+ramfs image through Uboot, but because S32G2 does not 

integrate USB PHY, it needs to be externally connected, and the Car gateway has less USB design, so 

it is not applicable.  

 Still have customer to use FOTA method, such as the DoIP in class AutoSar in M7 zone or adaptive 

AutoSar in A zone. 

Since the specific implementation of online programming belongs to customer customization, this 

paper will not discuss it. The purpose of this paper is to implement the serial boot to start the A core, 

solve the key technical problems, and provide customers with a basis. As for the tool itself, in order to 

adapt to the current implementation method, the serial port is used in a synchronous non-interrupted 1 
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byte method. If you need to improve efficiency, you can consider changing it to asynchronous 

interrupt multi-Bytes read and write,  with DMA enabled, but it needs to be adapted.



 

 
 
 

 


